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Chapter 1

Introduction to the BioRyx
200 System

Thank you for purchasing a BioRyx 200 optical trapping system. To ensure
safe operation, and to help you take full advantage of the system's features, it
is recommended that all personnel who will be using it familiarize themselves
with the contents of this manual, and with the BioRyx 200 onli ne Help.

1.1 Features of the BioRyx 200

The BioRyx 200 system is an advanced, versatile optical trapping device. Op-
tical traps, also known as laser tweezers, are tightly-focused beams of light
that can be used to capture and manipulate microscopic particles. Arryx's
patented HOT (Holographic Optical Trapping) technology, t he BioRyx 200 sys-
tem's custom-designed optics, and the BioRyx 200 software deliver features that
are not o�ered by conventional optical trapping systems:

� Production of up to two hundred optical traps in any con�gura tion within
the �eld of view

� Real-time three-dimensional control of each trap

� Intensity control of individual traps

� Creation of exotic trap types such as optical vortices and vertical line traps

� Compatibility with a variety of imaging techniques beyond t he standard
bright�eld imaging: dark�eld, phase contrast, 
uorescenc e, DIC, and more

� Programmable trap movements

� Record still and video data in a variety of formats

1



Chapter 2

Safety

This chapter contains important information and instructi ons for safe use of
the BioRyx 200 system. Please read this material carefully before operating
the system. Failure to follow these warnings can result in personal injury and
damage to the equipment.

2.1 Safety Symbols Used in This Manual

The symbols displayed below and throughout theBioRyx 200 System User's
Manual are reminders that all safety instructions should be read and understood
before any installation, operation, maintenance, or repair of the equipment is
attempted.

When these symbols are displayed in this manual, pay particular attention
to the safety information associated with the symbol.

WARNING

This symbol indicates that there is a potential hazard to the user's personal !
WARNINGsafety if instructions provided in the \WARNING" paragraph are not followed

or procedures are executed incorrectly.

CAUTION

This symbol indicates that the potential for data loss, software crash, or damage !
CAUTIONto the equipment exists if instructions given in the \CAUTIO N" paragraph are

not followed or procedures are executed incorrectly.

2.2 Laser Safety

The BioRyx 200 system is a Class 3B laser product, which complies with the
standards de�ned in IEC 60825-1, edition 1.2, dated August 2001, and CDRH

2



CHAPTER 2. SAFETY 3

standard 21 CFR 1040.10 and 1040.11, except for deviations pursuant to Laser
Notice 50, dated July 26, 2001.

High-intensity visible (BioRyx 200 VIS) or invisible (BioR yx 200 IR) laser
radiation is emitted through the microscope objective lens. Furthermore, the
BioRyx 200 system contains a Class 4 laser product as one of its components.
In order to avoid exposure to potentially harmful laser radiation, please read
and understand the safety information contained in this section and throughout
the BioRyx 200 System User's Manual.

Figure 2.1: Class 3B Laser Product Certi�cation Label for BioRyx 200 VIS

Figure 2.2: Class 3B Laser Product Certi�cation Label for BioRyx 200 IR

WARNING: Caution{Use of controls or adjustments or performance of pro-
cedures other than those speci�ed herein may result in hazardous radiation !

WARNINGexposure.

2.2.1 Location of Laser Aperture

When the BioRyx 200 system is properly assembled and operated, Class 3B
laser radiation is emitted through the microscope objective lens. The emitted
radiation is at a wavelength of either 532 nm (BioRyx 200 VIS) or 1064 nm
(BioRyx 200 IR), and has a maximum total power of 500 mW. The angle of
divergence of this light is determined by the numerical aperture (NA) value of
the objective lens in use. Figure 2.3, an overhead view of themicroscope stage,
shows the location of the laser aperture on the microscope.
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Figure 2.3: Location of laser aperture: Laser radiation is emitted through the
microscope objective lens.

2.2.2 Laser Emission Indicators

Active laser emission is indicated by the Emission LED on thefront panel of
the laser or laser power supply in the equipment rack. In BioRyx 200 systems
containing Spectra Physics lasers, the front panel of the power supply contains
an LED labeled \LASER EMISSION." When this LED is lit, laser e mission
is enabled. In BioRyx 200 systems containing Laser Quantum lasers, there
are three LEDs on the front panel of the equipment rack, labeled \POWER,"
\SHUTTER," and \EMISSION." The emission LED is the right-mo st of the
three indicators. When the power LED is lit, the laser power supply is switched
on. When the emission LED is lit, laser emission is occurring. When the shutter
LED is lit, the laser shutter is open. The locations of the emission indicators
are shown in Figure 2.4.

Figure 2.4: Location of Laser Emission LEDs on (a) Spectra Physics J20 power
supplies (Millennia Pro 2s and V-106C-3000 lasers) and (b) Laser Quantum
laser housing (opus 532 and ventus 1064 lasers)
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Additionally, laser emission is indicated in the status bar at the bottom of
the Main Window of the BioRyx 200 software, and in the Readings panel of the
Laser Control dialog box. These features are discussed in Chapter 6, and are
shown in in Figure 6.1 and in Figure 6.5, respectively.

2.2.3 Locations of Laser Warning Labels

Please note the locations of laser classi�cation and warning labels on the BioRyx
200 system, as indicated in Figures 2.5-2.10.

Figure 2.5: Class 3B Laser Product Certi�cation Label for (a) BioRyx 200 VIS
(b) BioRyx 200 IR

Figure 2.6: Laser Aperture Warning Label for (a) BioRyx 200 VIS (b) BioRyx
200 IR
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Figure 2.7: Access Panel Warning Label on HOT Box for (a) BioRyx 200 VIS
(b) BioRyx 200 IR

Figure 2.8: Access Panel Warning Labels on a laser enclosurefor a BioRyx 200
VIS system containing a Spectra Physics Millennia IIs lasersystem: (a) front
panel (b) rear panel (c) top panel. The appearance and text ofthese warning
labels is identical to that shown in Figure 2.7(a)
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Figure 2.9: Interior of equipment rack for a BioRyx 200 IR system containing
a Spectra Physics V-106C-3000 laser, with the Access Panel Warning Label
indicated by the arrow. The appearance and text of this label is identical to
that shown in Figure 2.7(b)

Figure 2.10: Access Panel Warning Label on laser enclosure for BioRyx 200 VIS
systems containing Laser Quantum opus 532 laser and BioRyx 200 IR systems
containing Laser Quantum ventus 1064 laser, located insidethe equipment rack.
The appearance and text of the labels are identical to those shown in Figure
2.7(a) and 2.7(b), respectively.
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2.2.4 Beam Speci�cations for Incorporated Lasers

WARNING: Decoupling the optical �ber that connects the laser to the HOT
Box may result in exposure to Class 4 laser radiation. Doing so may also damage !

WARNINGthe �ber. Consult an Arryx service technician before attempting to decouple
the optical �ber from either the laser head or the HOT Box.

WARNING: The laser systems used in the BioRyx 200 system emit Class 4
visible (BioRyx 200 VIS) or invisible (BioRyx 200 IR) laser r adiation. Class 4
laser radiation poses a safety hazard when direct exposure to the beam or to a
di�use re
ection occurs. To ensure that Class 4 laser radiation remains inac- !

WARNINGcessible during normal operation and maintenance of the BioRyx 200 system,
please note and follow all safety instructions given in thismanual, and in the
laser system manuals that were provided with the BioRyx 200 system.

The following information has been provided by the laser manufacturers,
and is provided here for reference. For more information on the laser systems
used in the BioRyx 200, see the manufacturer's literature provided with your
system.

Laser Quantum ventus 1064 OEM laser with smd 6000 OEM power
supply

Laser Wavelength 1064 nm
Maximum Power 3 W
Beam Divergence < 1.2 mrad

Laser Quantum opus 532 OEM laser with smd 6000 OEM power
supply

Laser Wavelength 532 nm
Maximum Power 2 W
Beam Divergence < 0.5 mrad

Spectra Physics V-106C-3000 OEM laser with J-series power s upply

Laser Wavelength 1064 nm
Maximum Power 3.01 W
Beam Divergence < 1.2 mrad

Spectra Physics Millennia Pro 2s laser system

Laser Wavelength 532 nm
Maximum Power 2 W
Beam Divergence < 0.5 mrad
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2.2.5 Laser Safety Precautions

The following safety precautions should be followed when using the BioRyx 200
system:

� Familiarize yourself with the instructions for operating t he laser contained
in Sections 4.1, 4.4, and 6.2 of this manual, and with the maintenance and
service information contained in Chapter 7.

� All persons who are in the same room as the BioRyx 200 system should
wear laser safety glasses which block the appropriate wavelength of visible
light or infrared radiation. For the BioRyx 200 VIS, this wav elength is
532 nm. For the BioRyx 200 IR, this wavelength is 1064 nm.

� Prior to each use, inspect the HOT Box, the microscope body, and the laser
housing to verify that no panels, port covers, or lids are loose, damaged,
distorted, or missing.

� Prior to each use, inspect the �ber optic cable connecting the laser to the
HOT Box to verify that it is not loose or damaged.

� Before placing a sample on, or removing one from, the microscope stage,
ensure that the laser radiation shield is in place and undamaged.

� Be sure that the laser shutter is closed and the laser is turned o� before
mounting a new objective lens on, or removing one from, the microscope
turret.

For general information about the safe use of laser products, consult your
organization's laser safety o�cer.

2.3 Electrical Safety

To reduce the risk of electrical shock, the BioRyx 200 systememploys a three-
wire electrical cable and plug to connect the equipment to earth ground. To
preserve this safety feature:

� Be sure to plug the BioRyx 200 system into a power outlet that is properly
wired and earth-grounded.

� Do not use a three-to-two wire plug adapter.

� Do not use a two-wire extension cord or a nongrounding multiple-outlet
power strip.

� Do not remove any panels or covers of equipment housings; panels and
covers should be removed only by Arryx service personnel.

� Disconnect the power to the system before performing any maintenance
or service.
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WARNING: Opening of any laser or power-supply housing may result in se-
vere electrical shock and/or mechanical injury, as well as damaging the equip- !

WARNINGment. For this reason, service that requires opening laser and power-supply
housings should only be performed by Arryx service personnel.

2.4 Electrostatic Discharge

CAUTION: The BioRyx 200 system contains many components which may
be severely and irreversibly damaged if subjected to electrostatic discharge.
To avoid this eventuality, personnel should properly ground themselves when !

CAUTIONworking with the system electronics, including the laser, the computer, and the
HOT Box. Direct any questions to Arryx service personnel.

2.5 Safety Maintenance

In order to ensure continued safe use of the BioRyx 200 system, read and follow
the service and maintenance guidelines given in Chapter 7.

2.6 Additional Safety Information

Several components of the BioRyx 200 system have their own safety precautions,
which can be found in the appropriate product manuals. Referto these product
manuals for additional safety information. In particular, please read and follow
the manufacturers' safety instructions for the microscopeand the laser system,
as well as for any optional accessories purchased for use with the BioRyx 200
system.



Chapter 3

Parts and Installation

The BioRyx 200 system consists of a number of components and has speci�c
installation requirements. This chapter will help you to pr epare for the instal-
lation of your system by an authorized Arryx representative.

CAUTION: Your BioRyx 200 system must be installed by an authorized Arryx
representative. Do not attempt �rst-time installation. !

CAUTION

3.1 Receiving and Inspection

Upon receiving your BioRyx 200 system, immediately inspectthe packaging for
signs of visible damage and report any such damage immediately to Arryx, Inc.
at (312) 726-6675.

3.2 Environmental Speci�cations

Table 3.2: Environmental Speci�cations

Altitude up to 2000 m above sea level
Temperature 10� C to 40� C (indoor use only)
Relative Humidity 80% max., non-condensing for tempera-

tures up to 31� C
Pollution degree 2

3.3 Installation Requirements

The BioRyx 200 system should be installed in a space ful�lling the following
requirements:

11
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Table 3.3: BioRyx 200 Installation Requirements

Suggested Work Area Microscope + Workstation: 60" wide �
35" deep � 40" high

Equipment Rack: 24" wide � 27" deep�
31" high

Electrical Requirements Voltage: 120 Volts AC (North America,
Japan), 220 Volts AC (Europe)

Current: 15 Amps (20 Amp dedicated cir-
cuit recommended)

3.4 Component List

The following are the components of a standard-con�guration BioRyx 200 sys-
tem. Depending on your purchasing options, your BioRyx 200 system may
contain additional or fewer components.

� Nikon TE2000 Microscope , with

{ Arryx HOT Box

{ Op-amp unit

{ Nikon objective lens set, including Nikon 60� oil-immersion objective
lens

{ Nikon objective lens risers

{ Nikon illumination power supply

{ Nikon manual stage or Prior ProScan II motorized stage (ProScan
II stage package also includes: control module, focus controller, and
joystick)

� Equipment Rack , containing

{ Rack-mounted computer with Arryx HOT USB security key

{ One of the following laser systems:

� BioRyx 200 IR
� Laser Quantum ventus 1064 OEM laser with smd 6000 OEM

power supply (maximum output 3 W at wavelength 1064 nm)
� Spectra Physics V-106C-3000 OEM laser with J-Series OEM

power supply (maximum output 3 W at wavelength 1064
nm)

� BioRyx 200 VIS
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� Laser Quantum opus 532 OEM laser with smd 6000 OEM
power supply (maximum output 2 W at wavelength 532 nm)

� Spectra Physics Millennia Pro 2s laser system, including
power supply (maximum output 2 W at wavelength 532 nm)

� DAC unit

� Computer monitor

� Computer mouse and keyboard

� CCD video camera

� Optical �ber connector

� Laser radiation shield

� HOT Calibration slide

� Ruler Calibration slide

� CD-ROM containing BioRyx 200 software and user documentation

� User documentation for BioRyx 200 components
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3.5 Diagrams of the Assembled BioRyx 200 Sys-
tem

Figures 3.1-3.3 show a properly-assembled BioRyx 200 system.

Figure 3.1: BioRyx 200 microscope assembly, showing Nikon TE2000 micro-
scope with (a) CCD video camera, (b) laser radiation shield,(c) Arryx HOT
Box.
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Figure 3.2: BioRyx 200 equipment rack for systems containing (a) Spectra
Physics lasers, and (b) Laser Quantum lasers, showing (i) laser enclosure, (ii)
computer, and (iii) laser power supply. In the Laser Quantum con�guration,
the laser power supply is located inside the laser enclosure.
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Figure 3.3: A complete, installed BioRyx 200 system



Chapter 4

Getting Started

This chapter details the steps for starting and using the BioRyx 200 system.
It includes instructions for setting up and calibrating the system, instructions
for basic operation, and referrals to sources of more information about each
component.

CAUTION: Before using your BioRyx 200 system for the �rst time, it must
be properly installed by an authorized Arryx representative. !

CAUTION

4.1 Powering Up the BioRyx 200 System

To start the BioRyx 200 system:

1. Verify that the optical �ber is connected to both the HOT Bo x and the
laser, and that all panels and port covers on the laser housing and micro-
scope are in place.

2. Verify that the laser radiation shield is in place, as shown in Figure 4.1.

WARNING: The laser radiation shield is not intended to provide com-
plete protection from the laser radiation produced by the BioRyx 200 sys- !

WARNINGtem. Arryx recommends that personnel always wear laser safety glasses
while operating the BioRyx 200 system.

3. Verify that all cables are connected and the power cords are plugged in.

17
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Figure 4.1: Placement of the laser radiation shield on the microscope condenser
and stage

4. If the laser power supply is not turned on, turn it on:

� If your BioRyx 200 system contains a Laser Quantum ventus or opus
laser, turn the control key on the front panel to the ON position.
The laser may take up to 10 minutes to warm up.

� If your BioRyx 200 system contains a Spectra Physics V-106C-3000
laser with a J-Series power supply, or a Spectra Physics Millennia Pro
2s laser system, turn the control key on the front panel of thepower
supply to the ON position. The laser may take up to 45 minutes to
warm up.

Figure 4.2: Powering up (a) a Spectra Physics V-106C-3000 orMillennia laser,
and (b) a Laser Quantum opus 532 or ventus 1064 lasers
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5. Depress the microscope illumination power button, shownin Figure 4.3,
if it is not already in the ON position.

Figure 4.3: The illumination power switch on the Nikon TE2000

6. Turn on the microscope illumination control unit, shown in Figure -illumps
by pushing the switch on the right-hand side. The switch will be illumi-
nated in green when the unit is turned on.

Figure 4.4: The Nikon illumination control unit

7. If the optional Prior ProScan II motorized stage is installed, turn on the
control unit, shown in Figure 4.5, by pushing the switch on the right-hand
side. The switch will be illuminated in green when the control unit is
turned on.

Figure 4.5: Prior ProScan II motorized stage control unit.
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8. Turn on the computer and start the BioRyx 200 software by double-
clicking the BioRyx 200 icon, shown in Figure 4.6, on the desktop.

Figure 4.6: BioRyx 200 software icon

4.2 Calibrating the System

When your BioRyx 200 system was installed, it should have been calibrated
by a certi�ed Arryx technician. However, it may occasionall y be necessary to
recalibrate the system, for example if you move the camera, or switch to a
di�erent one. Should you �nd it necessary to recalibrate your system, please
refer to Chapter 5.

NOTE: You do not need to recalibrate your system if you change to a di�erent
objective lens.

4.3 Loading a Sample onto the Microscope Stage

To prepare the BioRyx 200 system for use with a sample:

1. If the microscope stage already contains a sample, removeit from the
sample holder.

2. Select an objective lens sample by rotating it into position underneath
the sample holder. Use the microscope's coarse-focus knob to move the
objective lens to its lowest position.

3. If the selected objective lens requires an immersion 
uid(e.g. oil or water,
as indicated on the objective lens barrel), place the minimum necessary
amount onto the objective lens. Oil-immersion lenses require only a drop
or two of oil; water-immersion lenses generally require several drops of
water.

4. Place your sample securely into the sample holder on the microscope stage.

5. Center the area of the sample you wish to observe over the objective lens
by moving the microscope stage with the control knobs (manual stage) or
joystick (motorized stage).
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6. Raise the objective lens by adjusting the microscope focus knobs until the
immersion 
uid makes contact with the sample (if using an oil or water-
immersion objective lens) or until the objective lens is within its stated
working distance from the bottom of the sample (if using an air objective
lens).

CAUTION: Avoid pushing the objective lens into physical contact with !
CAUTIONthe sample container. Doing so can damage both the sample andthe

objective lens.

7. Observe the image of the sample in the Microscope Window ofthe BioRyx
200 software or through the microscope viewing optics and adjust the
microscope's �ne focus knob until the sample is in focus.

WARNING: Avoid looking through the microscope binocular when the
laser is turned on. !

WARNING
8. Place the laser light shield on the microscope stage.

For more information about using the microscope, see the Nikon TE2000
manual which was provided with your BioRyx 200 system.

4.4 Activating the Laser

In order to calibrate the BioRyx 200 system, or trap objects inside a sample
which has been loaded onto the microscope stage, the user must activate the
laser.

1. Verify that the laser power supply is turned on.

2. Verify that the laser light shield is in place.

3. Open theLaser menu in the BioRyx 200 software and selectTurn Laser
On to activate the laser.

4. Wait for the laser to reach its minimum power setting of 0.2 W, as indi-
cated in the lower-right-hand corner of the BioRyx 200 software window.

5. Open the Laser menu again and selectOpen Shutter to open the laser
shutter.

NOTE: Active laser emission is indicated at the bottom of the BioRyx 200
software window, and by LEDs which are located on either the front panel of
the laser (Laser Quantum opus 532 and ventus 1064 lasers) or the laser power
supply (Spectra Physics V-106C-300 or Millennia Pro 2s lasers).
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WARNING: Always wear laser safety glasses when the BioRyx 200 system !
WARNING

is in use.

You are now ready to begin using the BioRyx 200 system. To learn more
about using the BioRyx 200 software to trap and manipulate objects, refer to
Chapter 6, or to the online Help. To learn more about operating the laser, refer
to sections 2.2 and 6.2.

4.5 Shutting Down

To shut down the BioRyx 200 system:

1. Open theLaser menu in the BioRyx 200 software and selectClose Shut-
ter (toggles with Open Shutter ) to close the laser shutter.

2. Open the Laser menu again and selectTurn Laser O� to turn o� the
laser.

3. Exit the BioRyx 200 software.

4. Remove the laser light shield from the microscope stage.

5. Remove the sample from the microscope stage. Using lens tissue, gently
wipe any excess immersion 
uid (oil or water) from the objective lens.

6. Switch o� the power to the illuminator and to the control bo x for the
optional Prior ProScan II motorized stage, if it is installed.

4.6 Further Information About Operating the
BioRyx 200 System and Its Components

For further information on using the BioRyx 200 system, refer to Chapter 6 of
this manual.

To learn more about operating the microscope, the laser, or the optional
Prior ProScan II motorized stage, refer to the manufacturers' manuals that
were provided with your BioRyx 200 system.

To learn about using the BioRyx 200 software, refer to the BioRyx 200 online
Help which can be accessed through the BioRyx 200 software.

If you have any questions or problems with the BioRyx 200 software or
hardware, please refer to Chapter 8 of this manual, or contact an Arryx service
representative at (312) 726-6675 or send e-mail to service@arryx.com.



Chapter 5

Calibrating the BioRyx 200
System

Before the BioRyx 200 system can be used for optical trapping, it must be prop-
erly calibrated. The BioRyx 200 software contains two calibration procedures:
HOT Calibration and Ruler Calibration. HOT Calibration ena bles the software
to precisely position optical traps in the microscope �eld of view. Ruler Cali-
bration enables the software to correctly calculate trap paths and ensures that
length measurements given in real units (e.g.� m) are accurate.

When the BioRyx 200 system was installed, it was calibrated by a certi�ed
Arryx technician. However, it must be recalibrated if the HO T Box or camera
is moved or replaced. This chapter contains instructions for performing the
calibration procedures.

5.1 Ruler Calibration Procedure

The Ruler Calibration procedure accurately sets length scales in the BioRyx
200 software. This calibration was performed by an Arryx technician when
your BioRyx 200 system was installed. However, under some circumstances it
may be necessary to recalibrate the system.

In order to perform the Ruler Calibration procedure, you wil l need to use
the Ruler Calibration slide that was provided with the BioRy x 200 system. It
is shown in Figure 5.1.

To perform the Ruler Calibration procedure:

1. Start the BioRyx 200 software.

2. Be sure that the laser is turned o� and the laser shutter is closed.

3. Remove the laser safety shield from the microscope stage.

23
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Figure 5.1: BioRyx 200 Ruler Calibration slide

4. Be sure that the 60� Oil objective lens is in place, and that corresponding
objective lens setting is selected in the BioRyx 200 software. If necessary,
add a drop of immersion oil to the objective lens.

5. Place the BioRyx Ruler Calibration slide on the microscope stage, with
the label side face up.

6. Adjust the stage position, microscope focus, and illumination until the
calibration ruler is visible on the computer screen. An example image is
shown in Figure 5.2.

Figure 5.2: BioRyx 200 Ruler Calibration microscope image

7. In the BioRyx 200 software, open theFile menu, selectCalibrate , then
selectRuler .
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8. As instructed in the Calibrate Ruler dialog box (Figure 5.3), click on the
endpoints of two ruler lines near opposite edges of the �eld of view, and
enter the distance between the selected points in the text-entry box. Each
minor division on the Ruler Calibration slide corresponds to 10 � m.

Figure 5.3: Calibrate Ruler dialog box

9. Click OK.

10. Remove the Ruler Calibration slide from the microscope stage, and clean
the oil o� of it.

Once the Ruler Calibration procedure is performed with the 60� Oil objec-
tive lens, all the length scales in the software will automatically scale correctly
when objective lenses with di�erent magni�cation powers are selected and used.

5.2 HOT Calibration

The HOT Calibration procedure must be performed to enable the BioRyx 200
software to correctly place optical traps in the microscope�eld of view. When
the BioRyx 200 system was installed, HOT Calibration was performed by a
trained Arryx technician. However, if the HOT Box or a camera is moved or
replaced, recalibration will be necessary.

To perform the HOT Calibration procedure, the operator must use the Bio-
Ryx 200 Tweezer XY calibration slide, shown in Figure 5.4.

During the calibration process, several calibration points are activated one
at a time, and the software prompts the user to mark the positions of these
points on the computer screen. The calibration parameters are saved when the
procedure is completed.
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Figure 5.4: BioRyx 200 HOT Calibration slide

NOTE: HOT Calibration can be performed using any Nikon microscopeob-
jective lens. Arryx recommends using the 60� oil-immersion objective lens.

To perform the HOT Calibration procedure:

1. Start the BioRyx 200 software.

2. Be sure that the laser is turned o� and the laser shutter is closed.

3. In the BioRyx 200 software, open theFile menu, selectCalibrate , then
selectHOT . If the laser is on, a dialog box, shown in Figure 5.5, will give
a prompt to turn o� the laser. Click Skip only if the calibration chip is
already on the microscope stage.

Figure 5.5: HOT Calibration: Turn O� Laser dialog box

4. The next dialog box, shown in Figure 5.6 will give a prompt to remove the
laser light shield from the microscope stage and place the BioRyx HOT
Calibration slide on the stage, with the label side facing up. Follow the
instructions, then click OK . If the calibration slide is already in place,
click Skip .

5. Raise the objective lens by adjusting the microscope focus knobs until the
immersion 
uid makes contact with the calibration chip (if u sing an oil-
or water-immersion objective lens), or until the objective lens is within its
speci�ed working distance from the bottom of the sample (if using an air
objective lens).
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Figure 5.6: HOT Calibration: Place Calibration Chip on Stage dialog box

CAUTION: Avoid pushing the objective lens into physical contact with
the calibration slide. Doing so may damage both the sample and the !

CAUTIONobjective lens.

6. Click OK .

7. A dialog box, shown in Figure 5.7, will give a prompt to focus the micro-
scope until a bright spot appears on the screen. Follow the instructions,
then click OK .

Figure 5.7: HOT Calibration: Focus Microscope dialog box

8. One at a time, three calibration points will be created in the microscope.
The points will appear on the computer screen as bright spotsin the
Microscope Window, as shown in Figure 5.8. You will be asked to precisely
mark the position of each spot on the screen. For each spot:

(a) Click on the location of the bright spot appearing on the screen.

(b) To reposition the marker, click on a new position.

(c) To continue the calibration procedure, click OK . To abort the cali-
bration procedure, click Cancel .
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Figure 5.8: HOT Calibration: Locating the calibration poin ts. The calibration
points appear as bright spots in the Microscope Window. Whenprompted,
mark each point's location by clicking on it with the mouse. It will be marked
by a crosshair. In this image, two calibration points have already been located,
and the third is being displayed.

9. After the calibration points have been located, a dialog box will appear,
requesting con�rmation that the calibration was successful. If the traps
are correctly positioned over the bright spots, clickYes . If the traps are
not correctly positioned over the bright spots, click No . ChoosingNo will
restart the HOT calibration procedure.

Figure 5.9: HOT Calibration: Calibration Results dialog box
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10. When the calibration has been veri�ed, the laser will be turned o� and
the laser shutter closed. At this point, it is safe to remove the calibration
chip from the microscope stage.

5.3 HOT Calibration Without a Calibration Slide

It is recommended that the Arryx-provided HOT calibration s lide be used during
the HOT Calibration procedure. However, if a calibration slide is not available,
it is possible to calibrate the system without one.

Creating a Test Sample

For this procedure, you must �rst construct a test sample. The necessary com-
ponents are:

� A standard glass microscope slide and coverslip.

� A dilute suspension of some regular, di�usive particle. Arryx recommends
2 � m-diameter silica or polystyrene colloid.

Sandwich a few drops of the dilute suspension between the coverslip and the
microscope slide. It is helpful to seal the sample with some kind of adhesive
(e.g. 5-minute epoxy, clear nail polish, etc.). A schematicdiagram of such a
sample is shown in Figure 5.10.

(b)
(c)

(a)

Figure 5.10: Construction of a test sample for HOT Calibration. (a) Standard
glass microscope slide. (b) Dilute suspension of sphericalmicroscopic particles.
(c) Microscope coverslip.

Calibrating the HOT Box using the Test Sample

Once the test sample has been constructed:

1. Follow the instructions given in section 5.2 for HOT Calibration, substi-
tuting the test sample for the Arryx calibration slide.

2. When you are prompted to locate the calibration points, look for a particle
in the test sample which is not di�using (that is, it is not mov ing due to
Brownian motion). The particle will probably be located near one of the
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corners of the �eld of view. This particle should be held in the calibration
trap. If no such particle is visible, adjust the �eld of view b y moving the
microscope stage until a particle becomes trapped. Mark thelocation of
the trapped particle.

3. Repeat this process for the second and third calibration points.

Figure 5.11: Locating the HOT calibration traps by using a test sample. The
Microscope Window shows a phase contrast image of three testparticles that
are captured in the calibration traps, and one untrapped particle.



Chapter 6

Using the BioRyx 200
System

This chapter introduces the key operational features of theBioRyx 200 system
and the BioRyx 200 software. Use this chapter to familiarizeyourself with
the layout of the BioRyx 200 system's features and how the main components
work. Note that this chapter only covers basic operation; for full details on all
the features of the BioRyx 200 software, consult the BioRyx 200 online Help.

6.1 The BioRyx 200 Software Overview

This section introduces the major windows and controls of the BioRyx 200
software: the Main Window, the Microscope Window, and the Replay Window.

6.1.1 The Main Window

The BioRyx 200 Main Window opens when the BioRyx 200 softwareis started.
It contains tools and controls that are frequently used whenthe BioRyx 200
system is operated.

The top menu bar contains the File and Help menus. When a Microscope
Window is opened inside the Main Window, the top menu bar will also include
the Laser , Trap , and Window menus. If the camera is connected to the
computer, a Microscope Window will open automatically whenthe software is
started.

� Use the File menu to open and save trap �les, export images, set global
options, access calibration routines, and con�gure page setup and print
options. To load a recently used �le, open theFile menu and choose the
�le name at the bottom of the menu. To exit the program, choose Exit
at the bottom of the menu. A dialog box will prompt you to save t he trap
�le if this has not been done already.

31
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Figure 6.1: The BioRyx 200 Main Window, which contains (a) the Microscope
Window, and (b) the Main Status Bar.

� Use theLaser menu to turn the laser on and o�, open and close the laser
shutter, access the Laser Control dialog box, and check laser status and
settings.

� Use the Trap menu to select, cut, copy, paste, group, ungroup, and con-
�gure traps and paths in the Microscope Window.

� Use theWindow menu to arrange open windows in an overlapped fashion
(Cascade ) or a non-overlapped fashion (Tile ), or to arrange the applica-
tions minimized windows (Arrange Icons ). To access an open window,
open the Window menu and select the window's name.

� Use theHelp menu to access the online Help for the BioRyx 200 software.
To display software information, chooseAbout BioRyx 200 .



CHAPTER 6. USING THE BIORYX 200 SYSTEM 33

At the bottom of the Main Window is the Main Status Bar, indica ted in
Figure 6.1. The Main Status Bar displays the following information, from left
to right:

� Information about the tools and controls on the toolbars. When the mouse
cursor moves over a tool or control, an explanation of the control's function
appears in the Main Status Bar.

� Trap and path calculation status. When paths are being calculated, the
red bar shows the progress of background processing, and thegreen bar
displays the progress of calculation.

� Laser emission and power status.

6.1.2 The Microscope Window

The BioRyx 200 Microscope Window sits inside the Main Window, as shown in
Figure 6.1. It is the primary window for the BioRyx 200 software. It displays
live or paused video from the microscope. It enables the userto add and create
traps and paths for capturing and moving objects in the microscope and to
save trap �les, and to measure distances between points in the microscope. The
Microscope Window also contains controls for recording video to an AVI �le.

To open the Microscope Window, open theFile menu and chooseCapture
Device , then select the camera you wish to use.

Figure 6.2: The BioRyx 200 Microscope Window showing (a) theMicroscope
Toolbar, and (b) the Microscope Status Bar
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At the top of the Microscope Window is the Microscope Toolbar, which
contains tools and controls for operating the BioRyx 200 system.

Trap Tools and Controls

The trap tools and controls located on the Microscope Toolbar are:

� Select : Select a trap or group of traps.

� Add Path : Add a linear path to a trap.

� Add Trap : Creates a new trap.

� Activate Paths : Activates de�ned paths in the microscope. (Tog-
gles with Abort Activation.)

� Abort Activation : Terminates path activation process. (Toggles
with Activate Paths.)

� Ruler : Activates the on-screen ruler tool.

� Set Trap Speed : Sets the speed of trap motion along
activated paths.

� Favorite Trap Files : Select a favorite trap �le.

� Add Favorite Trap File : Creates the trap con�guration speci�ed
in the selected favorite trap �le.

� Trap Height Slider : Sets the height of selected trap or traps.

Video Tools and Controls

The tools and controls for displaying and recording video from the microscope
are:

� Play Video: Plays live video from the microscope. (Toggles with
Pause.)
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� Pause Video: Pauses video from the microscope. (Toggles with
Play.)

� Replay Mode: Opens the Replay Window, where you can replay
bu�ered video and mark locations of interest.

� Video Record: Records Microscope Window video to the hard
drive. (Toggles with Stop Recording.)

� Stop Recording: Stops the Microscope Window video recording.
(Toggles with Record.)

� Scale Bar: Overlays a scale bar on the video image.

� Trap Boundary: Displays a shaded overlay outside the �rst-order
di�raction boundary, indicating a region where trapping is not possible.

Laser Controls

The laser power can be set using the control in the MicroscopeToolbar:

� Laser Power Level : Sets the laser power.

Microscope Status Bar

The status bar at the bottom of the Microscope Window, shown in Figure 6.3
displays the following information:

� Capture Device : The camera currently in use.

� Objective Setting : The active microscope objective lens software set-
ting.

� Frame Rate : The current camera's video frame rate.

� Trap/Ruler : In Trap or Select mode, this pane displays the number of
active traps and the cursor position in the Microscope Window. In Ruler
mode, this pane displays the length of the ruler in� m.

� Path Speed : The current path speed setting in � m/s.

For further information on the tools and controls available in the Microscope
Window, read further in Chapter 6 of this manual, and consult the BioRyx 200
online Help.
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Figure 6.3: The Microscope Status Bar, showing (a) the current camera, (b) the
active objective lens setting, (c) the video frame rate, (d) trap position/ruler
data, and (e) the path speed.

6.1.3 The Replay Window

The most recently recorded video �le can be viewed from within the BioRyx 200
software using the Replay Window. The Replay Window enablesthe user to step
through the stored video frames and place markers over objects. These markers
can help the user position traps to capture 
uorescently labeled objects, and
can be used in conjunction with the On-Screen Ruler tool to measure distances
traveled by an object over several video frames.

To open the Replay Window, click on the Replay Mode tool in the
Microscope Window toolbar.

Figure 6.4: The BioRyx 200 Replay Window. The Replay Toolbar is located at
the top.
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The Replay Toolbar, located at the top of the Replay Window, contains
tools for viewing the most recently saved video and for overlaying markers onto
the Microscope Window.

The Replay Toolbar controls are:

� Overlay Markers : Toggles markers on or o� in the Replay Window
and the Microscope Window.

� Select Marker : Select a marker.

� Select Region : Selects markers in a region.

� Add Marker : Adds a marker to the Replay Window.

� Previous Image : Shows the previous video image.

� Next Image : Shows the next video image.

� Play : Plays the most recent video when clicked. Toggles with Pause.

� Pause : Pauses the playing video when clicked. Toggles with Play.

� Video Frame Slider : Scan through video frames.

For further information on the tools and controls available in the Replay
Window, consult the BioRyx 200 online Help.

6.2 Operating the Laser

WARNING: Use of controls or adjustments, or performance of procedures
other than those speci�ed herein, may result in harmful exposure to laser radi- !

WARNINGation.

6.2.1 Turning the Laser On and O�

Before the laser can be operated, it must be powered up, as described in Section
4.1. Once the laser is powered up, it can only be controlled through the BioRyx
200 software.

To activate laser emission, open theLaser menu and selectTurn Laser On
(toggles with Turn Laser O� ). To turn the laser o�, open the Laser menu
and selectTurn Laser O� .
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Opening and Closing the Laser Shutter

To open the shutter, open theLaser menu and selectOpen Shutter (toggles
with Close Shutter ). To close the shutter, open theLaser menu and select
Close Shutter .

WARNING: The BioRyx 200 system is a Class 3B laser product that outputs
visible (532 nm) or invisible (1064 nm) Class 3B laser radiation. Avoid exposure
to laser radiation. Arryx recommends that personnel alwayswear laser safety !

WARNINGglasses while using the BioRyx 200 system. See Chapter 2 for additional safety
information.

6.2.2 Setting the Laser Power

To set the laser power, click on the Laser Power pull-down menu in the
Microscope Toolbar and select the desired laser power.

6.2.3 Using the Laser Control Dialog Box

The laser can be controlled, and its status monitored, through the Laser Control
Window. To open the Laser Control dialog box, open theLaser menu and select
Control .

The Laser Control dialog box contains the following information and con-
trols:

� Model : Displays information about the laser model.

� Version : Displays the version number of the laser, or of signi�cant laser
system components.

� Settings : Controls for turning the laser on and o�, opening and closing
the shutter, and setting the laser power.

� Readings : Displays the current laser on/o� state, current laser power
reading, and the current shutter state.

� Messages: Laser control module message log. Messages include a date
and time stamp.
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Figure 6.5: The BioRyx 200 Laser Control dialog box

6.3 Viewing a Sample

To view a sample in the BioRyx 200 system, �rst load it onto the microscope
stage following the instructions of Section 4.3. The image of the sample will be
shown in the Microscope Window. To obtain the best image of the sample, it
may be necessary to adjust aspects of the video image, such asthe �eld of view,
the illumination, the microscope focus, or the video camerasettings.

6.3.1 Adjusting the Field of View

Changing the microscope �eld of view will change the area of the sample which
appears in the Microscope Window. To change the �eld of view,move the
microscope stage by using the stage control knobs (Nikon manual stage) or the
stage control joystick (Prior ProScan II motorized stage).

6.3.2 Adjusting the Illumination

The illumination brightness can be controlled by adjusting the brightness knob
on the illumination power supply. If the illumination is une ven across the �eld of
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view, it may be necessary to adjust the alignment of the microscope condenser.
See the Nikon TE2000 manual for details.

In addition to standard bright�eld illumination, the BioRy x 200 system can
be used with a number of Arryx and Nikon accessories which enable additional
imaging modes, including dark�eld illumination, phase contrast microscopy, 
u-
orescence microscopy, and di�erential interference contrast (DIC) microscopy.
Please see the documentation for the relevant accessories for instructions on
their use.

6.3.3 Focusing the Microscope

To change the microscope focus, carefully adjust the coarseand �ne focus knobs
on either side of the microscope. If the optional Prior ProScan II motorized stage
with focus control is installed, the �ne focus knob on the joystick can also be
used to adjust the microscope focus.

CAUTION: Be careful not to raise the microscope objective lens into contact
with the sample slide. This could cause damage to both the sample slide and !

CAUTIONthe objective lens.

NOTE: For further information on using the microscope, consult the Nikon
TE2000 manual which was provided with your BioRyx 200 system.

6.3.4 Adjusting the Video Settings

To change the video settings of the camera, open theFile menu and select
Video Settings to open the Video Settings dialog box. Click theProperties
button in the Capture Device tab to open a dialog box, shown in Figure 6.6
containing controls for for the active camera. Adjust the brightness, contrast,
white balance, and other settings as desired.
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Figure 6.6: The Video Capture Device Properties dialog box

6.4 Creating and Modifying Optical Traps

An optical trap is a region of very high light intensity that a ttracts and captures
dielectric objects. When the BioRyx 200 software creates a real optical trap

in the microscope, this trap is represented by a crosshair symbol in the
Microscope Window. Traps can be added to, moved within, and deleted from
the microscope by manipulating the corresponding crosshair trap symbols in
the Microscope Window.

6.4.1 Creating an Optical Trap

To create an optical trap in the microscope:

1. Click the Add Trap tool on the Microscope Toolbar.

2. Click inside the Microscope Window at the desired trap location. A trap

symbol will appear at the location of the new trap, as shown in Figure
6.10(a).

3. Optional: Set the trap to the desired height on the Trap Height Slider.

4. Optional: Change trap properties via the Trap Propertiesdialog box. This
dialog box can be accessed through theTrap menu, or by right-clicking
on a trap symbol.
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6.4.2 Selecting and Grouping Traps

Before existing optical traps can be modi�ed, they must �rst be selected in
the Microscope Window. Selected traps can be formed into a permanent group
which will always be modi�ed as a unit.

Selecting Traps

To select traps in the Microscope Window:

1. Click the Select tool on the Microscope Toolbar.

2. Click on the trap you would like to select in the MicroscopeWindow. To
select multiple traps, hold down the Ctrl key while clicking on each trap
to be selected. Alternatively, click in the Microscope Window and drag
a rectangular selection region around the desired traps. All traps in this
region will be selected.

Selected traps are displayed in green, and can be copied, cut, and pasted
to and from the Windows clipboard by using the keyboard commands Ctrl-C,
Ctrl-X, and Ctrl-V, respectively.

Grouping Traps

To create a group of traps:

1. Select the traps to be grouped.

2. Open theTrap menu and selectGroup , or type Ctrl-G on the keyboard.

To ungroup a group of traps, select the group by clicking on any trap in the
group, then open the Trap menu and selectUngroup , or type Ctrl-U on the
keyboard.

6.4.3 Modifying Selected Traps

Selected traps can be moved or deleted, and several of their properties can be
adjusted. If multiple traps are selected, all the selected traps will be moved,
deleted, or otherwise modi�ed in the same manner.

Deleting Traps

To delete traps in the Microscope Window:

1. Select the traps to be deleted.

2. Press the Delete key on the keyboard. The selected traps will be deleted.
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Moving Traps

To move traps in the Microscope Window:

1. Select the traps to be moved.

2. Click on any selected trap and drag the selected traps to their new position.

Adjusting Trap Height

To change the height of traps relative to the microscope's imaging plane:

1. Select the traps.

2. Adjust the Trap Height Slider to the desired height. Alter natively, use the
scroll wheel on the computer mouse to adjust the height of thetraps.

3. The new trap height will be displayed at the bottom of the Tr ap Height
Slider.

Figure 6.7: The Trap Height Slider, located at the right-hand side of the Mi-
croscope Window.

NOTE: The size of the trap symbol in the Microscope Window will vary, de-
pending on the trap height, as shown in Figure 6.10(a). A larger trap symbol
indicates that the trap is closer to the bottom of the sample chamber.

6.4.4 Viewing and Changing Trap Properties

To view or adjust the properties of a trap or group of traps:

1. Select the trap or group.

2. Right-click on one of the selected traps, or open theTrap menu and select
Trap Properties . The Trap Properties dialog box will appear, displaying
the trap's location, group status, intensity, charge, and length.

3. Adjust the trap properties as desired.

For more information on the controls in the Trap Properties dialog box, see
Section 6.4.5 of this manual, or the BioRyx 200 online Help.
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6.4.5 The Trap Properties Dialog Box

The Trap Properties dialog box enables the user to adjust various properties of
a selected trap or group of traps. The adjustable trap properties are: location
(X, Y, and Z), intensity, charge, and length. The Trap Proper ties dialog box is
shown in Figure 6.8.

Figure 6.8: Trap Properties dialog box

The trap properties are:

� Location: These parameters specify the three-dimensional location of the
selected trap or traps. X and Y are the on-screen coordinatesof the trap
center, in pixels. The X and Y controls are disabled if multiple traps are
selected. Z is the height of the trap center relative to the imaging plane,
in =mum. Clicking on the scroll arrows updates the trap position in real
time, or the user can type a value into the text entry box and click on the
Apply button.

� Intensity: This parameter controls the relative laser power intensities
of individual traps. For example, a trap whose intensity is set to 0.5
contains half as much laser power as a trap whose intensity isset to 1.0,
and is consequently half as strong. Moving the slider or clicking on the
scroll arrows updates the trap intensity in real time, or the user can type
a value into the text entry box and click on the Apply button. T he Reset
button sets the Intensity to the default value of 1.0.

Note that the Intensity control does not change the total amount of
laser power going into the system; it adjusts the balance of power among
multiple traps. This control has no e�ect when there is only one trap.
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� Charge: To create an optical vortex, enter a non-zero number for this
parameter. The selected trap will change from a point to a ring that
imparts angular momentum to trapped particles. The larger the charge,
the larger the radius of the ring will be. Choosing positive or negative
values controls the direction of spinning; positive chargecorresponds to
anticlockwise rotation. Moving the slider or clicking on the scroll arrows
updates the charge in real time, or the user can type a value into the text
entry box and click on the Apply button. The Reset button sets Charge
to the default value of 0.0. Figure 6.9 shows a point trap (charge = 0.0)
and an optical vortex (charge = 30.4).

Figure 6.9: Images of (a) a point trap (charge = 0) (b) an optical vortex (charge
= 30:4)

� Length: Varying this parameter changes a point trap into a vertical
line trap which extends along the optical axis (the Z direction). The
vertical line trap can be used to manipulate extended objects, or to catch
several smaller objects in a vertical stack. Adjusting the Length parameter
varies both the vertical extent of the line trap (in arbitrar y units) and its
position relative to the image plane (this is a side e�ect which can be
compensated for by using the trap height slider). Choosing positive or
negative values determines whether the line trap extends above (positive)
or below (negative) the image plane. Moving the slider or clicking on the
scroll arrows updates the length parameter in real time, or the user can
type a value into the text entry box and click on the Apply butt on. The
Reset button sets Length to the default value of 0.0.

� Grouping: The Grouping checkbox is enabled if more than one trap or
a group of traps has been selected. Checking this box causes the selected
traps to be handled as a �xed group for future manipulations. Unchecking
the Grouping checkbox ungroups the traps.
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6.5 Moving Objects With Pre-De�ned Paths

Each optical trap can be programmed to move along a three-dimensional user-
de�ned path. This feature can be used to move or distort objects in a pre-de�ned
fashion.

6.5.1 De�ning a Path

To create a path for a trap:

1. Click the Add Path tool on the Microscope Toolbar.

2. To add a path to a trap, click on the trap, then drag the path end-point to
the desired stopping point. If desired, set the end-point'sheight by using
the Trap Height Slider or the mouse scroll wheel.

3. To add an additional segment to the path, click on the path's endpoint,
and drag the new endpoint to the desired position. Repeat to create a
path with as many segments as desired.

NOTE:

� If the trap is part of a group, an identical path will be de�ned for each
trap of that group.

� Paths are unidirectional. To reverse motion along a path, create a second
path which starts at the original path's endpoint and goes to the starting
point of the original path.

6.5.2 Activating Paths

When a path is de�ned in the Microscope Window, the changes that appear
on the screen are not immediately activated in the microscope. To activate the

paths you have de�ned, click the Activate Paths tool in the Microscope
Toolbar. To abort the activation process, click on the Abort Path Activation

tool.
Paths can be set to execute repeatedly. Open theFile menu and select

Options to open the HOT Options dialog box. In the Trap Activation Set tings
panel, check theContinuous Execute Loop box. Now, when the Path Ac-
tivation tool is used, path activation will continue until t he process is aborted.

NOTE: Paths cannot be activated individually. All de�ned paths ar e executed
simultaneously.
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6.5.3 Modifying Paths

Once a path is de�ned, it can be modi�ed by moving the endpoints of its seg-
ments, or by adding or deleting segments.

� To relocate the endpoint of a path segment, select the endpoint and drag
it to its new location. To move an entire path, select all of its points and
move them together.

� To delete a path segment, select its endpoint and press the Delete key on
the keyboard.

� To insert an additional segment into a multi-segment path, click on the

Add Path tool, then click on the endpoint of the path segment where
you would like to insert the new segment. Drag the path to create the
new path segment.

Figure 6.10: Creating and editing traps and paths in the Microscope Window:
(a) three traps at di�erent heights, (b) one trap with a singl e-segment path, (c)
one trap with a multi-segment, three-dimensional path.
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6.5.4 Setting the Path Speed

Use the Path Speed slider in the Microscope Toolbar to set the
speed at which an optical trap moves along a user-de�ned path. The numerical
value of the path speed (in� m/s) is displayed in the status bar at the bottom
of the Microscope Window.

The fastest speed a trapped object can move depends upon the strength of
the optical trap(s) holding it and the strength of other forc es exerted on the
object, such as viscous drag force or interaction with otherobjects. If an object
escapes from the optical trap as it moves along a path, consider reducing the
path step size or the path speed.

The path speed will automatically change if the microscope objective lens is
changed, or if the path step size is adjusted.

6.5.5 Setting the Path Step Size

A trap in the BioRyx 200 system moves along a user-de�ned pathin a series
of discrete steps. The length of these steps can be set by the user. Ideally, the
distance between consecutive steps should be no larger thanabout one-half the
size of the object being moved. For very small, highly-di�usive objects (e.g.
smaller than 1 � m in diameter for a particle suspended in water), the step size
should be even smaller to reduce the chance of the object escaping from the
trap.

To set the path step size, open theFile menu and selectOptions . Enter
the desired step size, in� m, in the Path Step Size text box, then click OK .

The path step size will automatically change if the microscope objective lens
is changed. Changing the path step size will automatically change the path
speed.

For more information about working with paths, refer to the B ioRyx 200
online Help.

6.6 Managing Trap Files

A given con�guration of traps and paths can be saved in a trap (*.TRP) �le.
A trap �le describes the position of traps in the Microscope Window, their
associated properties, and any paths assigned to the traps.By saving a trap
con�guration, you can restore it for use at any point in the fu ture.

6.6.1 Saving and Loading Trap Files

To save a trap �le:

1. Con�gure the traps and/or paths in the Microscope Window.

2. Open the File menu and selectSave.
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3. If the trap con�guration is not already associated with a � le, a dialog box
will open, asking what to name the new �le. Enter the desired � le name
and click Save.

To save a trap �le with a di�erent �le name, open the File menu and select
Save As . Enter the new �le name in the text box, and click Save.

To load a trap �le:

1. Open the File menu and chooseOpen .

2. Locate and select the �le you would like to load, then clickOpen . Alterna-

tively, select a pro�le from the Favorite Traps pull-down me nu

in the Microscope Toolbar, and click the Add Favorite tool.

3. A dialog box will appear, asking whether the trap pro�le contained in
the �le should be appended to the traps which already appear in the
Microscope Window. Click Yes to add the trap �le to the existing traps.
Click No to replace the current traps with the trap �le that is being loaded.

6.6.2 Favorite Trap Files List

Frequently-used trap �les can be saved as Favorites, and accessed via the Fa-
vorite Trap Files pull-down menu in the Microscope Toolbar.

To edit the Favorite Trap Files list:

1. Open theTrap menu and chooseEdit Favorite to open the Add/Remove
Favorite dialog box, which is shown in Figure 6.11.

Figure 6.11: Add/Remove Favorite dialog box
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2. To add a trap �le to the Favorites list:

� Click Add .

� Find and select the desired trap �le.

� Click Open .

3. To remove a trap �le from the Favorites list:

� Select the trap �le.

� Click Remove .

� Click OK .

Additionally, a trap �le can be added to the Favorites List wh en it is created
by checking Add to Favorites in the Save As dialog box.

To load a favorite trap �le:

1. Click the Favorite Trap Files pull-down menu on the
Microscope Toolbar.

2. Select the trap �le you wish to load.

3. Click the Add Favorite button on the Microscope Toolbar.

For more information about working with trap �les, refer to t he BioRyx 200
online Help.

6.7 Saving Video and Still Images

The BioRyx 200 software has the capability to save data from the microscope
as both movies (AVI �les) and still images (JPEG, TIFF, and Wi ndows Bitmap
formats), for later viewing, analysis, and editing.

6.7.1 Recording Video to a File

To record video from the Microscope Window and save it in an AVI �le:

1. Open theFile menu and selectVideo Settings . The Video Setting dialog
box, shown in Figure 6.12, will open.

2. In the Video Settings dialog box, select the Record tab.

3. Optional: select a video compression format from the Video Compression
pull-down combo box. Use the scroll buttons at the right-hand side of the
box to select a format.

4. Enter the desired �le name in the Output Filename text entr y box.
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Figure 6.12: Video Setting dialog box, Record tab

5. Click OK .

6. To begin recording, click the Record button on the Microscope Tool-
bar.

7. To end recording, click the Stop button.

NOTE:

� If you select a �lename of the form \*0#.avi" where \*" repres ents any
character string, and \0#" represents a number string beginning with 0
(e.g. capture01.avi), then the output �lename will automat ically incre-
ment by one each time a video �le is recorded.

� Image overlays such as trap symbols, the scale bar, and trap boundary
will not be visible in the recorded video.

For more information about recording video �les and video settings, see the
BioRyx 200 online Help.

6.7.2 Saving Still Images

An image appearing in the Microscope Window can be exported to an image �le.
The available graphics formats are JPEG (*.JPG), Windows Bitmap (*.BMP),
and TIFF (*.TIF).

To export the microscope image to a �le:

1. Open the File menu and selectExport .
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2. In the File Name text box, enter a name for the image �le.

3. In the Save As Type list box, select the format in which to save the image.

4. Click Save.

NOTE: Image overlays such as trap symbols, the scale bar, and �rst-order
di�raction boundary will be visible in the exported image. F or more information
on video image overlays, see Section 6.8.

For more information about exporting image �les and video settings, see the
BioRyx 200 online Help.

6.8 Video Image Overlays

6.8.1 Overview of Video Overlays

In the BioRyx 200 software, many graphical symbols can be overlaid on the
video image in the Microscope Window. These overlays provide assistance in
trapping and in analyzing data from the microscope. Figure 6.13 shows a sample
Microscope Window, containing examples of the various image overlays.

The video image overlays are:

� Trapping boundary : The \�rst-order di�raction region" is the area in
the microscope's trapping plane where the BioRyx 200 can create full-
strength optical traps. Beyond this region, trapping power is signi�cantly
reduced. The size of this area depends on the wavelength of the trapping
light; it is larger for longer wavelength light).

The BioRyx 200 software can display the boundary of the �rst-order
di�raction region. This feature is mainly useful as a diagnostic device. To
view the boundary of the trapping region in the Microscope Window, click

the Trap Boundary tool in the Microscope Toolbar. A colored overlay,
shown in Figure 6.13(a) will appear in the Microscope Window, indicating
which part of the �eld of view lies beyond the �rst-order di�r action zone.
Traps placed in this region will have reduced or no power. To remove the

overlay, click the Trap Boundary tool again.

� Trap symbol : Indicates the position of an optical trap. Shown in Figure
6.13(b).

� Path symbols : Indicates the route to be taken by a user-de�ned path.
Shown in Figure 6.13(c).

� On-screen ruler : The on-screen ruler tool allows the user to measure
real distances between two points in the Microscope Window in real units
(i.e. � m). To use the on-screen ruler:
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Figure 6.13: Video Overlays in the Microscope Window: (a) trap boundary (b)
trap symbol (c) trap with a multi-segment path (d) on-screen ruler (e) markers
overlaid from Replay Window (f) 10 � m scale bar
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{ Click the Ruler tool on the Microscope Toolbar. The status bar
at the bottom of the Microscope Window will now say Ruler Mode .

{ Click on the �rst point. A blue cross will appear.

{ Click on the second point. A blue line, like the one in Figure 6.13(d)
will appear between the two points, and the status bar will indicate
the length of that line, in � m.

� Position markers : Objects can be marked in the Replay Window, and
the markers can be overlaid onto the active Microscope Window. These
markers can be moved and resized in the Replay Window, and thecor-
responding symbols will appear in the Microscope Window, asshown in
Figure 6.13(e). For instructions on using the Replay Window to overlay
markers on the Microscope Window, refer to the BioRyx onlineHelp.

� Scale bar : A scale bar can be added to the image in the Microscope

Window. To overlay a scale bar, click the Scale Bar tool on the
Microscope Toolbar. The scale bar will appear in the lower right-hand
corner of the Microscope Window, as shown in Figure 6.13(f).The length
of the scale bar will be automatically set to a value that is appropriate
for the objective lens in use. To remove the scale bar, click the Scale Bar

tool again.

NOTE: Image overlays will appear in exported still image �les. They will not
appear in recorded AVI �les.

6.8.2 Setting the Opacity of Video Overlays

The opacity (alpha blend) level for all video overlays in theMicroscope Window
can be adjusted from 0 to 100, where 0 is invisible, and 100 is completely opaque.

To set overlay alpha blend level:

� Open the File menu and chooseVideo Settings . The Video Setting
dialog box will appear.

� In the Video Setting dialog box, select theCapture Device tab.

� Adjust the Alpha Blend slider to the desired level.

6.9 Switching Microscope Objective Lenses

The BioRyx 200 optics are optimized for use with the suppliedNikon 60� 1.4
numerical aperture (NA) oil-immersion objective lens. However, the system can



CHAPTER 6. USING THE BIORYX 200 SYSTEM 55

be equipped with a number of di�erent Nikon objective lenses, some of which
may be more appropriate than the 60� 1.4 NA oil-immersion objective lens for
certain applications and imaging techniques.

Note that a high-NA objective lens is necessary for optical trapping. At lower
NA values, it becomes increasingly di�cult to trap objects. Arryx recommends
using an objective lens of at least 0.8 NA for optical trapping. For imaging only,
any objective lens that is compatible with the Nikon TE2000 microscope can
be used.

6.9.1 Adding an Objective Lens

WARNING: Before adding or removing an objective lens from the microscope,
be sure that the laser is turned o� and the shutter is closed. Failure to do so !

WARNINGmay result in exposure to harmful laser radiation.

To add an objective lens:

1. Verify that the laser is turned o� and the shutter is closed.

2. Mount the new objective lens on the objective turret.

3. In the BioRyx 200 software, open theFile menu and selectOptions .

4. In the Microscope Objective panel of the HOT Options dialog box, click
on Edit List . The Edit Objective List dialog box, shown in Figure 6.14,
will open.

Figure 6.14: Edit Objective List dialog box

5. In the Select Objective pull-down menu, select< New Objective > .
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6. Enter a descriptive name for the new objective lens setting in the Name
�eld.

7. Enter the objective lens' magni�cation and numerical aperture (NA) in
the appropriate �elds. The Focal Length and Back Aperture values are
calculated automatically. The magni�cation and NA values are marked
on the objective lens.

8. Click the Save button.

6.9.2 Selecting an Objective Lens

To select an objective lens:

1. Verify that the laser is turned o� and the shutter is closed.

2. Remove any sample from the microscope stage.

3. Clean any excess immersion 
uid (oil or water) from the oldobjective lens
and from the sample.

4. Rotate the microscope objective turret to bring the new objective lens
into place beneath the stage.

5. In the BioRyx 200 software, open theFile menu and selectOptions .

6. Using the pull-down menu in the Microscope Objective panel, select the
new objective lens from the list of available settings. If the new objective
lens does not appear on the pull-down menu, click onEdit List to create
an entry, as described in Section 6.9.1.

7. Click OK .

The BioRyx 200 system and software are now ready for use with the new
objective lens. All length scales and settings are scaled automatically when the
appropriate objective lens is selected in the HOT Options dialog box, provided
that the system has been properly calibrated, as described in Chapter 5.

For more information on objective lenses, see the Nikon TE2000 manual
which was provided with your BioRyx 200 system. For more information on
objective lens settings in the BioRyx 200 software, see the BioRyx 200 online
Help.

6.10 Other Features of the BioRyx 200 Software

The BioRyx 200 software has many capabilities beyond the basic ones discussed
in this chapter. For further information about the features of the BioRyx 200
system and the BioRyx 200 software, please consult the BioRyx 200 online Help.



Chapter 7

Service and Maintenance

This chapter contains information on procedures for maintaining the BioRyx
200 system and its components so that the system remains in good working
order. It also describes service procedures which should only be performed by
or in consultation with a trained Arryx service technician.

WARNING: Failure to follow the instructions and recommendations in this !
WARNINGchapter may result in exposure to harmful laser radiation.

CAUTION: Failure to follow the instructions and recommendations in this
chapter may result in damage to the BioRyx 200 system or to itscomponents. !

CAUTION

7.1 Maintaining the BioRyx 200 HOT Box

The BioRyx 200 HOT Box contains sensitive opto-electronic components, which
must be kept clean and properly aligned. To keep the HOT Box ingood working
order:

� Never leave any objective port on the microscope nosepiece open. These
objective ports should always have an objective lens or objective port cap
in them. This will prevent dust from entering the HOT Box and d egrading
the trapping ability of the system.

� When using an oil-immersion objective lens, do not leave excess oil on the
objective lens. Immersion oil can leak down inside the objective lens and
contaminate both the objective lens and the HOT Box optics.

� Always keep the side camera ports and epi
uroescence port ofthe mi-
croscope covered. This prevents dust from entering the HOT Box and
contaminating its components.

� Do not attempt to open or dismantle the HOT Box. Doing so will con-
taminate and misalign the optics and void the warranty, and may expose
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personnel to harmful laser radiation.

7.2 Periodic Safety Inspection

The following inspection procedure should be periodicallyperformed, in order
to ensure ongoing safe operation of the BioRyx 200 system:

� With the laser turned o�, verify that all laser safety warnin g labels are
a�xed to the equipment in the locations shown in Section 2.2.

� With the laser turned o�, verify that all the removable panel s of the laser
enclosure, shown in Section 2.2, are secured in place.

� With the laser turned o�, verify that the optical �ber connec ting the laser
to the HOT Box is connected at both ends, and that the �ber itself has
not been bent or damaged.

� With the laser turned o�, verify that all the panels of the HOT Box are
intact and secured in place.

� Verify that the laser emission indicator LED lights up when t he laser is
turned on. The location of the emission LED is shown in Section 2.2.

� Test the laser shutter. This can be done by trapping a particle during
normal operation, and then closing the laser shutter. The particle should
no longer be trapped. If the trap appears to be active when theshutter is
supposedly closed, turn o� the laser and contact Arryx post-sales support.
Do not operate the BioRyx 200 system until the shutter has been repaired.

If the inspection reveals a problem or defect, do not operatethe BioRyx 200
system. Contact Arryx post-sales support at (312) 726-6675, or by sending
e-mail to service@arryx.com.

7.3 Additional Maintenance Procedures and Pre-
cautions

In addition to the precautions listed in Section 7.1 for maintaining the HOT Box,
the following precautions should be taken to ensure the continued functionality
of the BioRyx 200 system:

� Do not bend the optical �ber connecting the laser to the HOT Box at a
sharp angle.

� If one of the series of connections between the computer and the HOT Box
is accidentally disconnected, shut down the computer priorto reconnecting
it.
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� Follow all suggested maintenance procedures and precautions described in
the equipment manuals for the laser and Nikon TE2000 microscope which
were provided with the BioRyx 200 system.

� Follow all suggested maintenance procedures and precautions described
in the equipment manuals for any optional accessories purchased for use
with the BioRyx 200 system.

7.4 Servicing the BioRyx 200 System

The following service activities, if performed improperly, have the potential to
cause damage to the BioRyx 200 equipment, void your warranty, and expose
the servicer to harmful laser radiation. For these reasons,they should only be
performed by, or in consultation with, a trained Arryx servi ce technician.

� Disassembling the BioRyx 200 system.

� Disconnecting the �ber optic cable connecting the HOT Box and the laser.

� Realigning or otherwise adjusting the HOT Box.

� Opening any panel on the HOT Box.

� Removing the microscope objective turret or any part of the HOT Box
from the microscope.

� Installing or removing Arryx, Nikon, or third-party micros cope accessories.

� Disconnecting any of connections between the HOT Box and thecom-
puter.

� Performing any sort of service on the laser or the laser powersupply.

To contact an Arryx service technician, call Arryx at (312) 7 26-6675, or send
e-mail to service@arryx.com.
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Troubleshooting

If you receive an error message or if the BioRyx 200 system is not functioning
as expected, check for these common problems and try the suggested solutions.
If the problem is not listed below, or if the suggested remedydoes not work,
contact Arryx post-sales support at (312) 726-6652, or by sinking e-mail to
service@arryx.com.

8.1 Troubleshooting Common Problems

8.1.1 Imaging Problems

Symptom Cause Remedy

Microscope video
not visible in Mi-
croscope Window

Illumination too low Increase illumination, make sure
that the condenser does not have a
Phase Contrast ring in place

Binocular/camera lever set to
\binocular"

Switch lever so that light is going to
camera

Imaging light being sent to wrong
microscope camera port

Turn port selection knob to correct
position

Camera cables disconnected Reconnect cables

Poor image qual-
ity

Dirty or poorly-adjusted microscope
optics

Consult troubleshooting section in
Nikon TE2000 manual
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8.1.2 Trapping Problems

Symptom Cause Remedy

No traps are cre-
ated

No laser light Make sure laser shutter is open

Attempting to place traps beyond
the �rst-order di�raction zone

Use �rst-order di�raction zone tool
to locate trap boundary & adjust
stage so that object is in trapping
zone

Traps in wrong lo-
cation

Improper HOT calibration Perform HOT Calibration routine

1.6� magni�er lens in place Switch to 1� magni�cation

Extra, unmovable
trap in �eld of
view

Misaligned HOT Box component Consult Arryx service technician

Extra traps which
move with desired
traps

HOT Box electronics in bad state Reboot computer

Traps are unex-
pectedly weak

HOT Box electronics in bad state Reboot computer

Trap intensity set too low Check Trap Properties, set Intensity
to 1

NA of objective lens too low for
trapping

Switch to higher-NA objective lens

Optical aberration due to trapping
deep inside sample cell

Switch to objective lens with longer
working distance

Trap paths not
calculated prop-
erly (e.g. wrong
length, too slow)

Length scale improperly calibrated Perform Ruler Calibration routine

Objective lens settings in software
don't match objective lens in use

Select correct objective lens settings

HOT Box electronics in bad state Reboot computer

Objects fall out of
paths

Path step size larger than object Reduce step size

Fluid drag force greater than trap-
ping force

Reduce path speed, increase laser
power

Length scale improperly calibrated Perform Ruler Calibration routine

Sample damaged
by trap

Sample absorbs light at laser wave-
length

Reduce laser power, use Ring Mode
trapping

Object propelled
upward, out of
trap

Scattering force from laser light
stronger than trapping force

Reduce laser power, use Ring Mode
trapping, use a higher-NA objective
lens
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8.1.3 Software Problems

Symptom Cause Remedy

Unable to com-
municate with
laser

Cable between laser and computer
disconnected

Reconnect cable

No Microscope
Window

Cable between camera and com-
puter disconnected

Reconnect cable

Camera not selected in software In the File menu, select Capture
Device and select the camera

Microscope Window misplaced in
Main Window

In the Window menu, select Cas-
cade to reset window position

Computer re-
sponse time is
slow

Too many applications running Close applications

8.2 General Suggestions

If you have a problem with the BioRyx 200 system that is not covered in Section
8.1, the following remedies may be helpful:

� Verify that all cables are connected.

� Close and restart the BioRyx 200 software.

� Reboot the computer.

� If you are using an oil-immersion objective lens, clean the oil o� of the
objective lens and the sample, and apply fresh oil.

� If you are using a water-immersion objective lens, add more water.

� Verify that the objective lens settings in the software correspond to the
objective lens which is currently in use.

� Verify that the length scales and HOT Box are correctly calibrated. If they
are not, perform the Ruler Calibration routine or the HOT Cal ibration
routine described in Chapter 5.



Chapter 9

Contact Information

To obtain post-sales support for the BioRyx 200 system, callan Arryx service
representative at (312) 726-6675, or e-mail service@arryx.com.

Arryx can be contacted by mail at:

Arryx, Inc.
316 North Michigan Avenue
Suite CL20
Chicago, IL 60601

Arryx on the Web: http://www.arryx.com/
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Appendix A

Glossary of Terms

This glossary contains a list of terms pertaining to the BioRyx 200 system and
to optical trapping in general.

Charge In the BioRyx 200 software, a parameter which describes the amount
of angular momentum carried by an optical vortex. Charge also correlates
with the radius of the optical vortex{the bigger the charge value, the larger
the radius.

Class 3B Regulatory classi�cation given to lasers which pose a safety hazard
when direct exposure to the beam occurs. This includes lasers which emit
in the wavelength range of 302.5 nm to 106 nm, with an accessible emission
limit of 500 mW.

Class 4 Regulatory classi�cation given to lasers which pose a safety hazard
when exposure to either the beam itself or to a di�use re
ection occurs.
This includes lasers which emit in the wavelength range of 302.5 nm to
106 nm, with an accessible emission limit that exceeds 500 mW.

Dielectric Matter which does not contain free electric charges, i.e. a non-
conducting material.

HOT Acronym for Holographic Optical Trapping, the key technology used in
the BioRyx 200 system.

HOT Box The opto-electronic component of the BioRyx 200 system which
encodes the user-de�ned trap pro�le onto the input laser beam. It is
shown in Figure 3.1(c).

Intensity In the BioRyx 200 software, a parameter that determines how laser
light is divided among multiple traps. For example, if there are two traps
with intensity values 1 and 0.5, the second trap will be half as bright as
the �rst one, and its trapping strength will be similarly red uced.

Laser A source of coherent, monochromatic (single-wavelength) light.
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Length In the BioRyx 200 software, a parameter that determines the extent
and direction of a vertical line trap.

Numerical Aperture (NA) A parameter that describes the light-gathering
power of a lens, de�ned as:NA = n sin� 0, where n is the refractive index
of the material from which the lens is made, and� 0 is the half-angle of
the widest cone of light accepted by the lens.

Optical Trap A region of very high light intensity which attracts and capt ures
dielectric particles. Also referred to as \optical tweezer" or \laser tweezer."

Optical Vortex An optical trap which takes the form of a ring of light, and
which imparts angular momentum to trapped particles.

Overlay In the BioRyx 200 software, anything that is drawn by the software
over the video image in the Microscope Window. Examples are trap and
path symbols, markers, the scale bar, and the trap boundary.

Path In the BioRyx 200 software, a user-de�ned trajectory along which an
optical trap moves.

Refractive Index A parameter describing the degree of refraction experienced
by light entering a material. It is de�ned as the ratio of the s peed of light
in vacuum to the speed of light in the material, (n = cvacuum =cmaterial ).

Ring Mode Tweezing A technique by which one blocks a portion of the laser
light going into the objective lens, speci�ed by numerical aperture (NA)
or by the radius at the objective lens' back aperture.

Trap File In the BioRyx 200 software, a �le that describes a con�guration of
traps and paths.

Vertical Line Trap An optical trap which extends along the direction of prop-
agation of light.
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ruler, 25{27

slide, 26
trap location, 27{31
without a calibration slide, 31

camera settings, 42
caution

symbol, 3
charge

trap property, 47

deleting traps, 44

electrical
requirements, 14
safety, 10, 11

environmental speci�cations, 13
export image, 53

favorite trap �les, 51{52
�eld of view, 41
�les

image, 53
trap, 50{52
video, 52

focus, 42

glossary, 69{70
group

creating, 44, 47
ungrouping, 44

grouping
trap property, 47

HOT Box
maintenance, 59

illumination, 41
image

exporting, 53
focus, 42
illumination, 41
settings, 42
troubleshooting, 63

intensity
trap property, 46

labels
warning, 6

laser
activation, 23
aperture, 4
control, 37

dialog box, 40
controls, 39{40
division of power among multiple

traps, 46
emission, 23, 39
emission indicators, 23
operation, 39{40
power setting, 40
powering up, 20
radiation shield, 20
safety, 3{10, 19, 23, 24, 39, 40

66
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shutdown, 24
shutter, 40
speci�cations, 9
turning o�, 39
turning on, 39
warning, 24, 40

laser,emission indicators, 5
length

trap property, 47
line trap, vertical, 47
location

trap property, 46

maintenance, 59{61
HOT Box, 59
objective lens, 59

microscope
components, 14
�eld of view, 41
focus, 42
loading a sample, 22
objective lens, 56{58
operation, 41{42
window

status bar, 37
microscope window, 35

toolbar, 36
moving traps, 45

next image button, 39
numerical aperture

e�ect on optical trapping, 57

objective lens
HOT calibration, 28
adding, 57
caution, 42
changing, 56{58
maintenance, 59
mounting, 10
path speed and, 50
path step size and, 50
selecting, 58

objective list, editing, 57
optical trap, 1
optical vortex, 47

overlay markers tool, 39

path
speed, 37
step size, 50

objective lens and, 50
path speed slider, 50
paths, 48{50

activation, 48
adding a segment, 49
de�ning, 48, 49
deleting, 49
direction of motion, 48
grouped traps and, 48
modifying, 49
moving, 49
multi-segment, 48, 49
repeated execution, 48
speed, 50

objective lens and, 50
pause button

microscope window, 37
replay window, 39

play button
microscope window, 36
replay window, 39

previous image button, 39

record button, 37
microscope window, 53

replay tool, 37
replay window, 38{39

tools, 39
ruler

calibration, 25{27
tool, 36

safety, 3{11
electrical, 10, 11
laser, 3{10, 19, 23, 24, 39, 57, 61
precautions, 10
warning, 4, 9, 11, 13, 19, 23, 24,

39, 40, 57, 59
scale bar tool, 37
select marker tool, 39
select region tool, 39
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select tool, 36, 44
service, 61
software

icon, 22
main status bar, 35
main window, 33
microscope status bar, 37
microscope toolbar, 36
microscope window, 35
overview, 33{39
starting, 22
troubleshooting, 65

speci�cations
environmental, 13
laser, 9

status bar
main, 35

stop record button, 37
microscope window, 53

trap, 1
charge, 47
intensity, 46
length, 47
location calibration, 27{31
tools, 36

trap boundary tool, 37
trap �les, 50{52

favorite, 51{52
loading, 51
saving, 50

trap height
slider, 36

trap height slider, 45
trap properties, 46
trap speed

slider, 36
traps, 43{47

creating, 43
deleting, 44
grouping, 44, 47
modifying, 44{45
moving, 45
properties, 45, 46
selecting, 44
setting height, 45, 49

troubleshooting, 64
ungrouping, 44

troubleshooting, 63{65
imaging, 63
software, 65
traps, 64

vertical line trap, 47
video

camera settings, 42
recording to a �le, 52
replay, 39
tools

microscope window, 36{37
replay window, 39

video frame slider, 39
video settings, 42, 52

warning
labels, 6
laser, 57
safety, 4, 9, 11, 13, 19, 23, 39, 40,

57, 59
symbol, 3


